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EzData is a unique tool that allows quick creation of forms. A Microsoft Access database is
automatically generated for every form. Data can be entered into the database either manually using the
database toolbar and form validation document or you can scan in the forms in using any Twain
compliant scanner. Data from scanned forms is displayed in the form validation document for review
before storing it to the database.
EzData comes with over 12 dictionaries including U.S. cities, first names, surnames, states, medical,
legal and more which can be used to improve recognition accuracy. A custom dictionary editor allows
you to create your own dictionaries as needed. In addition to use of a secondary character recognition
engine allows you to quickly review process forms and immediately know which if any fields need to be
validated manually to ensure accuracy.
To simplify the form creation process EzData provides 21+ formatted entry fields for all common data
types including phone numbers, Social Security numbers, ZIP codes, e-mail addresses, and more. These
formatted fields allow you to enter a variety of text, members, alphanumeric fields into any form.
Checkbox fields are also supplied to allow simple selection and extremely accurate data entry. We
provide two types of checkboxes. One for use when only a single selection would apply and the other for
cases when multiple selections would be desired.
In addition we provide dozens of field templates and users can create their own new ones. A custom
field template is a set of predefined, formatted fields and can be placed in new forms to speed up the
form development process. For example there is a template for a customer's name and address
information that can be placed in a form in one step.
You can add boxes, lines, bitmap images, and text into forms to enhance the look and usability.
Included with EzData is an Html report generation tool for extracting useful information out of the
database. This allows you to create reports from data stored in any Microsoft access database. Importing
the data into Microsoft Excel allows you to quickly create graphs, charts, and enhanced table based

reports. Since the database is standard it can also be imported into many other tools. For protection of
critical data a database password can be used.

System Requirements
●
●
●
●
●
●

●

PC with a Pentium-class processor Pentium 90 or higher
Microsoft Windows 2000/XP
128MB or more of RAM
100MB of hard disk space free
CD-ROM drive or Modem for software installation
(Optional) Twain compliant scanner that can produce black and white windows BMP images at a
resolution of 200-400DPI for scanned input features.
(Optional) Color Inkjet printer for printing forms.

Installation
Insert the disk into the CD-ROM and the installation wizard should start automatically. If the wizard
does not open automatically, you can use Setup.exe found at the root if the disk. Go to the windows Start
Menu and select Run. Then use the browse button to locate and run the Setup.exe file on the CD-ROM.
Follow the installation wizard instructions to complete the installation.

Initial Setup
Step 1: Optimizing Character Recognition
Step 2: Printing Forms
Related Topics: Troubleshooting
You can use our example forms and example images to test the product the can be accessed through the
help menu.

Overview
It is important to take the time to properly set up your application for the particular scanner and printer
that you use. Be aware that many scanners claim to be TWAIN compliant are not truly TWAIN
compliant. If you encounter scanning related problems see the Trouble Shooting.

Optimizing Character Recognition
The primary character recognition engine was trained on over 20,000 samples of handwriting. It should
yield results that are greater the 97% accurate for numbers, 92% for upper case letters and 97% for lower
case letters. The secondary tertiary and quad character recognition engines are trained on a smaller set of
samples and standard fonts but should yield similar accuracy.
In addition you can select a character set preference when processing with the secondary, tertiary, or
quad engines. Including accented characters or standard fonts. With the aide of the automatic dictionary
lookup and the specialized form layout the attainable accuracy for all fields should be 98% or better.
To configure the default usage of the character recognition engines and character sets used use the
application preferences dialog.
To improve the accuracy it is important to calibrate printed forms to work with the scanner and color
printer you use. Even without calibration the default settings should yield acceptable results on most
scanners and printers.
To start the calibration process use the File Menu and select the Print Forms entry. This will bring up the
print forms dialog. Select the “Calibration Form” entry from the drop list and press the “ok” button to
print it.
After the form has printed fill out the fields using a pencil or pen similar to what you will normally use.
Then check the Show Scanned Image entry under the Scanner Menu. This will display the scanned in
image for review. Make sure and correct the Scanner Brightness before making any adjustments to the
form dropout color. If the text you wrote in the fields before scanning is not clearly readable or has lots
of missing segments then darken the scanner brightness to help compensate for pencil type or writing
style. Pressing firmly while writing will also help darken the text and make it more readable to the
scanner. Refer to the example on the card for what it should look like when properly calibrated for both
brightness and form dropout color. Now that the brightness has been calibrated it may be necessary to
lighten the form color to insure the form is dropped out when scanned in as a black and white image.
Use the Set Form Colors entry under the form menu to adjust the color. If you have lots of black dots
from the form showing up around the text entered in the fields you should lighten the color of the form
until only a few or less show up. It is not necessary to remove them all since there is a advanced image
filter that is used to clean up a field before processing it.
At this point the application should be optimized to insure maximum accuracy and enjoyment.
Remember to recalibrate the system if you change scanners or printers to insure you are always getting
the maximum accuracy attainable.

Sample Forms, Form Images, and Databases.
Provided with EzData are several sample forms and form images. To print a sample form select "Print
Forms" from the file menu then picked for me wish to print. To open an example for image for
processing select "Open" from the file menu go up one level then click on "Form Images" and select the
example for image to open. Then select form image files as the file type (*.fim). Select a form image to
load. Once the image is loaded click the "Process Image" icon on the toolbar or under the file menu.
This will process to form and display the validation view document.
Use the database menu to open an example database for viewing or generate a report using a report
menu.

EzData supports the standard Microsoft command line options. In addition you can also perform
command line batch scanning, custom record printing, and exporting the data via command line options.
Lists for records and fields can be separated by a "," or ":", or ";". Lists for suggested value field can
contain a "," or ":" as a separator but not a ";" because multiple selection checkbox fields use a ";" as a
separator.
You can use the "-start" command to start an instance of EzData that stays running until you run a "stop" command. All other commands will be forwarded to the single running instance. If you have not
started a single instance using "-start" then a new instance of EzData runs for each command and exits
when the command is complete.
Start/Stop EzData Command Arguments
-start
-stop

Starts a single instance of EzData running. This allows you to issue multiple script
commands without running a new instance of EzData for each command.
Stops a single instance of EzData

Scan Command Arguments
-scan

required, starts tool and does scanning for manual verification, user closes tool after saving
to database

Batch Scanning Command Arguments
-batchscan

required, starts with tool hidden, performs scanning, auto saves to database,
generates a report, closes the tool

Batch Process Command Arguments
-batchprocess

required

-filelist

<file list>

optional if -dirlist specified otherwise required

-dirlist

<directory list>

optional if -filelist specified otherwise required

Print Records Batch Command Arguments
-printrecords

<form name>

required

-dbpassword

<password>

optional, unless database has a password specified

-records

<record list>

required

-fields

<field list>

optional, default = all

-usesugvalues

<field list[=value]
optional (use suggested values default or specified on field)
>

-copies

integer

optional, default = 1
Print Form Batch Command Arguments

-printform

<form name>

required

-fields

<field[=value], ...> optional, (print form with field values prefilled)

-usesugvalues

<field[=value], ...> optional (use suggested values default or specified on field)

-copies

integer

optional, default = 1

Export Data Batch Command Arguments
-exportdata

<form name>

required

-dbpassword

<password>

optional, unless database has a password specified

-records

<record list>

required

-fields

<field list>

optional, default = all

-exportfile

filename

required

-delimiter

<delimiter>

default is a ","

Import Data Batch Command Arguments
-importdata

<form name>

required

-dbpassword

<password>

optional, unless database has a password specified

-importfile

filename

required

-delimiter

<delimiter>

default is a ","

Clear Database Batch Command Arguments
-cleardb

<form name>

required

Examples:
echo "Starting a single instance of EzData to send multiple commands to."
start "EzData Server App" "ezdata.exe" -start
ezdata.exe -exportdata "Medical History.crf" -fields "First_Name, Last_Name" -exportfile
"exportMedicalHistory.txt"
ezdata.exe -stop
ezdata.exe -scan
ezdata.exe -batchscan
ezdata.exe -batchprocess -dirlist "C:\My Documents\My ICR Images 1;C:\My Documents\My ICR
Images 2"
ezdata.exe -batchprocess -filelist "Medical History 01.fim;Medical History 02.fim"

ezdata.exe -exportdata "Medical History.crf" -records "1,2" -fields "First_Name,MI,Last_Name" exportfile exportdata1.txt
ezdata.exe -importdata "Medical History.crf" -importfile exportdata1.txt
ezdata.exe -cleardb "Medical History.crf"
ezdata.exe -printrecords "Medical History.crf" -records 1 -fields "First_Name,MI,Last_Name" -copies 1
ezdata.exe -printform "Medical History.crf" -fields "First_Name=John,MI=R,Last_Name=Smith" usesugvalues "Exercise=2, Medical_Conditions=Arthritis;Angina" -copies 1
ezdata.exe -printrecords "Medical History.crf" -records 1 -fields "First_Name,MI,Last_Name" usesugvalues "First_Name=John, MI=L, Last_Name=Smith,Allergies=Soy;Egg;Peanuts"

About Creative ICR Inc
Creative ICR, Inc. was founded in 1999 and is located in Beaverton Oregon. You can contact Creative
ICR, Inc. by sending email to contact@creativeicr.com or support@creativeicr.com on the Internet at
http://www.creativeicr.com.
Creative ICR is an innovative company that was founded in 1999. Our specialty is intelligent character
recognition for hand written forms.
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Create New Form
To create a new form select new under the file menu. After the form is displayed you can select form
attributes under the form menu and customize the form size, borders, database name, number of pages,
form identification number, and form title. You can also edit form attributes by double-clicking on the
form identification number.

Setting Form Attributes
Form Title
Form Identification Number
Form Size
Multi-page Forms
Form Database Name

Form Database Password
Form Border Attributes
Form Grid Size
Form Margins
Form Units
Form Title
The form title is a text item that is displayed at the top center of each page. Although it is automatically
generated for you you can edit it to change the colors, font size, as well as text value. Click the right
mouse button over the item to show before menu, select from the menu to modify the title attributes.
Form Identification Number
Each form requires a unique identification number. This number is used to determined which forms are
being scanned in. Any valid four digit number is acceptable. Click on the form identification number to
edit the the form attributes. You can also move the form identification number if you do not like the
location but it must be visible on the form and obscured by other fields.
Form Size
You can customize the size of a form using any of the standard sizes in the drop-down list or you can
select custom and then set the width and height. Form sizes are limited by the constraints of the printers
to a maximum size of a legal document.
Multi-page Forms
You can create multi-page forms by setting the number of pages in the form attribute dialog. Select form
attributes under the form menu to display the form attributes dialog. When scanning a multi-page form
the individual page order is not important. If you're scanning a batch of multi-page forms you must
ensure that all of the pages for the first form are scanned before scanning pages for additional forms.
Form Database Name
A Microsoft access database is automatically generated for each form. The name of the database is set in
the form attributes dialog. Select form attributes under the form menu to display the form attributes
dialog. The database file that is generated is located in the database directory underneath the installation
directory. This would typically be C:\Program Files\Creative ICR\EzData\Databases.
Typically most forms would only have one database table because they have less than 255 fields. You
can select to include the record number in each additional table generated by checking the checkbox

"Create a record number for each table in multitable forms".
You can also choose to generate a GUID our global unique identifier for a database by checking the
checkbox "Create GUID's for database records". Typically most forms would only have one database
table because they have less than 255 fields. You can select to include a GUID in each additional table
generated by checking the checkbox "Create a GUID for each table in multitable forms".
When forms are scanned in a validation form is displayed. This allows any errors to be corrected before
saving the data to the database. After verification you can use the database toolbar or the file menus to
save the form to the database. If you scanned in a batch of files you can save them all at one time by
selecting "Save All Processed Forms" under the file menu.
If you do not save the form validation view document to the database all data will be lost when the
document is closed or you switch to another database record.
Form Database Password
If you need to secure the information that is being saved you can set a password for the database. This
will require you enter this password to access the database or to save scanned in forms to the database.
When scanning in a batch of forms you are asked for a password. If you have not specified a password
for the forms that you can leave it blank. If the forms you're scanning require a password this enables
you to enter it only once even though you're scanning multiple forms. If you are scanning several
different forms and they all have passwords you'll be asked for the password as each form scanned.
Use GUID in Database Records
If this checkbox is checked database records for the formed will contain a unique global ID field to
identify each record.
Form Border Attributes
You can display a border around the form by setting a border width and color in the form attributes
dialog. Select form attributes under the form menu to display the form attributes dialog.
Form Grid Size
To assist and placement of form fields you can set the grid size in the form attributes dialog. Although
the grid is not displayed items will automatically snap to the closest grid location when placed or moved.
Form Margins

Set the left, right, top, bottom margins as desired for your form and the specified printer.
Form Units
Check the metric units checkbox if you prefer viewing form and field sizes and Metric rather than
English units.
Print a GUID on each form.
Check the print GUID checkbox if you want a globally unique identifier (GUID) printed on each form.
Add form image full path to database.
Check the add form image full path checkbox if you want a store a path to the image file used for the
record in the database.

Textbox Fields
To add a new text box recognition field select "Add Textbox" under the form menu. This displays the
text box attributes dialog. You can also display an alternate form menu by using the right mouse button
when over the form document.
The field name for a text box is also the name that will be used to represent that field in the database. For
this reason it is important that you pick a name that has some relationship to the data you are expecting
to be entered. For example if you are adding a text box for a first name you might want to use the words
"First Name" for the field name. This will ensure when you generate reports the field names you see will
be meaningful and explain what the data is.
The text box format is used to determine the type of text field. There are over 22 field types available
ranging from simple text and number fields to more complex fields like Social Security numbers, street
addresses, phone numbers, and more.
If you restrict the expected characters to only uppercase or only lowercase you'll get increased accuracy.
The default setting is mixed case to simplify data entry by users who may not be familiar with the form.
For mixed alphanumeric fields select the Char Type to be alphanumeric. Only use alphanumeric fields
where it is required like street addresses or other fields were the text can include numbers. Accuracy for
alphanumeric fields is generally not as good as other field types because some numeric characters look
identical to alpha characters. For example 1 and l look the same when written by hand.

For floating point numbers you can use one of the three different floating point formats. The fixed
floating point formats support xxx.y and xxx.yy floating point numbers. Where the decimal point is
fixed but you can control the number of significant digits to the left of the decimal point. For more
advanced floating point number entry you can use the free format floating point number format. It
supports most standard floating point number formats (12.34, +12.3e-2, 12.3d+1, -1.234e-3, ...).
For fields that contain a fixed or specified format of alphanumeric characters you can select the field
type "Specified Format" and supply the type of each character. For example [MNNNN] specifies a 5
character string that contains a mixed case letter followed by four numbers. The following table shows
the possible values for specifying specific field formats. Character format identifiers must be enclosed in
the special format brackets otherwise they will be interpreted as normal characters.
Special Format
Brackets

[]

Uppercase character

U

Lowercase character

L

Mixed case character

M

Number

N

Punctuation

P

Alphanumeric character X
Examples specified formats:
Phone Number

[NNN]-[NNN]-[NNNN]

Currency

$[NNNN].[NN]

Alpha numeric identification
number

ID:[MM][NNNN]

To increase recognition accuracy the use of a dictionary is recommended for fields where it is
appropriate. We supply more than 12 dictionaries with the product. Included is a dictionary editor that
can be used to create your own custom dictionaries. The dictionary files are located in the dictionary
directory underneath the installation directory. This would typically be C:\Program Files\Creative ICR
\EzData\Dictionary.
To a create multi-line title for a textbox insert a "\" into the title text where you want the line break to be.
To create a multiple line text box field set the number of lines to more than 1. Multi-line fields can be

useful when you need to enter something like a short comment.
If you wish to display a field without individual character boxes then uncheck the individual character
box checkbox. Note that this may decrease the accuracy of the recognition if users enter characters that
are touching.
To edit/enter a default value for a field select the field then select edit value from the form menu. This
will bring up an editing window for you to make the changes. You can use the Tab key to navigate to
the next field. Holding the Shift key while pressing the Tab key will take you to the previous field. To
close the correction/edit window without saving the changes press the Esc key. To close the correction/
edit window and apply the changes just click on any blank area in the form.
To display a suggested value in the dropout color for a field just enter the desired text in the suggested
value entry when editing the field. The date and time fields have default values (I.E. MM-DD-YYYY).
Other fields do not have a value initially. If you would like to clear the value for a date or time field just
select the text and press backspace or delete.
You can show and hide default values using the form menu. Select the fields then use the form menu to
either show or hide the values for those fields.
You can save the current set of values for a field by using before menu in selecting "Save Value Set".
Once a value set is saved you can reload it at a later time.

Checkbox Fields
To add a new checkbox recognition field select "Add Checkbox" under the form menu. This displays the
text box attributes dialog. You can also display an alternate form menu by using the right mouse button
when over the form document.
The field name for a checkbox is also the name that will be used to represent that field in the database.
For this reason it is important that you pick a name that has some relationship to the data you are
expecting to be entered. For example if you are adding a checkbox for salary range you might want to
use the words "Salary Range" for the field name. This will ensure when you generate reports the field
names you see will be meaningful and explain what the data is.
You can modify the default field value to be something different than the label by checking the
checkbox to enable the database value entry fields.
To add entries to a checkbox field type the desired label into the label entry field then press the add item

button. You can customize the font, color, orientation of the label text and its relationship to the
checkbox. To a create multi-line label for a checkbox insert a "\" into the label text where you want the
line break to be.
In the case where there's only one valid selection make sure the multiple selection checkbox is
unchecked. This creates a checkbox with circles and only one value can be checked the time.
To create a check box field that allows multiple selection make sure to multiple selection check box is
checked. This creates a checkbox with squares and users may check any fields that apply.
You can create a grid or multi-line set of checkboxes by changing the boxes per line value. This controls
how many checkboxes will be displayed on each line.
To edit/enter a default value for a field select the field then select edit value from the form menu. This
will bring up an editing window for you to make the changes. You can use the Tab key to navigate to
the next field. Holding the Shift key while pressing the Tab key will take you to the previous field. To
close the correction/edit window without saving the changes press the Esc key. To close the correction/
edit window and apply the changes just click on any blank area in the form.
You can show and hide default values using the form menu. Select the fields then use the form menu to
either show or hide the values for those fields.
You can save the current set of values for a field by using before menu in selecting "Save Value Set".
Once a value set is saved you can reload it at a later time.

Image Box Field
To add an image box field select "Add Image Box" under the form menu. This displays the image box
attributes dialog. You can also display an alternate form menu by using the right mouse button when
over the form document.
Image box fields are useful for capturing bitmap images of signatures or other hand drawn information
which he once stored in the database.

BarCode Box Field
To add a bar-code box field select "Add BarCode Box" under the form menu. This displays the bar-code

box attributes dialog. You can also display an alternate form menu by using the right mouse button when
over the form document.
Bar-code box fields are useful for capturing a barcode value and type to store in the database.

Boxes
To add a box for decoration or grouping of fields select "Add Box" under the form menu. This displays
the box attributes dialog. You can also display an alternate form menu by using the right mouse button
when over the form document. Boxes are purely for decoration and organization and do not affect the
database. They cannot be used as recognition fields.

Lines
To add a line for decoration or grouping select "Add Line" under the form menu. This displays the box
attributes dialog. You can also display an alternate form menu by using the right mouse button when
over the form document. Lines are purely for decoration and organization and do not affect the database.

Bitmap Images
To add a bitmap image for decoration or grouping select "Add Bitmap" under the form menu. This
displays the bitmap attributes dialog. You can also display an alternate form menu by using the right
mouse button when over the form document. Bitmaps images are purely for decoration and organization
and do not affect the database.

Text
To add text for decoration or grouping select "Add Text" under the form menu. This displays the box
attributes dialog. You can also display an alternate form menu by using the right mouse button when
over the form document. Text items are purely for decoration and organization and do not affect the
database.
To create multi-line text insert a "\" into the text where you want the line break to be. You can use the

attributes dialog to determine if the text is center, left, or right justified.
Example:
This is\a test
Displays As:
This is
a test
To edit/enter a default value for a field select the field then select edit value from the form menu. This
will bring up an editing window for you to make the changes. You can use the Tab key to navigate to
the next field. Holding the Shift key while pressing the Tab key will take you to the previous field. To
close the correction/edit window without saving the changes press the Esc key. To close the correction/
edit window and apply the changes just click on any blank area in the form.
You can show and hide default values using the form menu. Select the fields then use the form menu to
either show or hide the values for those fields.
You can save the current set of values for a field by using before menu in selecting "Save Value Set".
Once a value set is saved you can reload it at a later time.

Dictionaries
Dictionaries are for use with text box recognition fields. They help improve the accuracy of recognition.
EzData comes with more than 12 dictionaries. Included is a dictionary editor that can be used to create
your own custom dictionaries. The dictionary files are located in the dictionary directory underneath the
installation directory. This would typically be C:\Program Files\Creative ICR\EzData\Dictionary.
The format for a dictionary file is a standard text document with space separated or line separated words.
You can use any text editing tool to create a dictionary file or you can use the built-in dictionary editor.
To use the dictionary editor select "Dictionary Editor" under the form menu to display the dictionary
editor dialog. You can also display an alternate form menu by using the right mouse button when over
the form document.

Custom Templates
Currently EzData comes with more than 30 custom templates to help you quickly create new forms. A

custom template is a predefined field or set of fields that is saved. You can create your own custom
templates by selecting a set of fields and other items. To save the selected items as a custom template
select "Save Custom Template" under the form menu . You can also display an alternate form menu by
using the right mouse button when over the form document.
To add a Custom template to your form select "Add Custom Template" under the form menu . You can
also display an alternate form menu by using the right mouse button when over the form document.

Database Groups
Some forms may require repeating a set of fields multiple times were each set or group of fields should
be saved as a separate database record along with any other non grouped fields. For example if you have
a form with the current date, a person's name, and phone number repeated 20 times saving the entire
form as one database record would make it difficult to extract information and reports about a particular
person. If you use the database group feature it would save each group, (date, name, phone), as an
individual record making report generation more useful.
To create a database group select "Group -> Group Selected Items" under the form menu . You can also
display an alternate form menu by using the right mouse button when over the form document. This will
create a group for the set of selected fields. You can now copy and paste a group or select "Group ->
Duplicate Group" under the form menu to create multiple instances of your group. You can only have
one group definition in a form.
To remove a group you can either delete it or select "Group -> Ungroup Selected Items" under the form
menu . Ungrouping the selected items leaves them on the form but removes the group definition.

Validation/database
The form validation/database view allows you to enter, delete, and edit information in the database.
When a form is scanned in a form validation view is created to display the scanned information. This
provides an opportunity to correct any mistakes before saving it to the database. After verification of the
data you can use the database toolbar or the file menus to save the form to the database.
To verify a questionable value simply click the right mouse button over the field. The actual images
used during recognition for that field will be displayed for validation. You can use the Tab key to
navigate to the next field. Holding the Shift key while pressing the Tab key will take you to the previous
field. Press the Esc key or click the mouse on an empty part of the form to return to the normal display.

To make corrections use the left mouse button and click on the field you wish to edit. This will bring up
and editing window for you to make the changes. You can use the Tab key to navigate to the next field.
Holding the Shift key while pressing the Tab key will take you to the previous field. Press the Esc key or
click the mouse on an empty part of the form to return to the normal display canceling any edits. To
apply the edits press the enter key, tab to the next field, or simply click the mouse over any blank area in
the form.
If you scanned in a batch of files you can save them all at one time by selecting "Save All Processed
Forms" under the file menu.
You can also manually enter new records into the database using the database toolbar for adding,
editing, deleting records from the database.
The database file that is generated is located in the database directory underneath the installation
directory. This would typically be C:\Program Files\Creative ICR\EzData\Databases.
The database is a standard Microsoft access database. This allows you to import the data into other tools
like Microsoft Excel and generate charts and graphs or enhanced reports.
When validating a scanned in form the color of the text indicates the to recognition confidence for that
field. A color of red indicates the recognition engine had difficulty determining the value and as a low
confidence it is correct. A color of yellow indicates the recognition engine was unsure. A color of black
indicates the recognition engine as a high confidence that the value is correct. These indicators are
provided to assist in validation but just because a value is black does not mean its correct. Likewise a
value that is red does not necessarily mean that is not correct.

Image
Image files are created by scanning in forms. The main use of an image file is to verify that you have a
reasonable image for processing. The text should be dark and clear and the form boxes should not be
visible. If you're able to see the individual character boxes in the scanned in an age you should lighten
the dropout color for the form. To adjust the color of individual character boxes select "Set Form
Dropout Color" from the scan menu.
If the text is not dark enough you can adjust the brightness of the scan by selecting "Set Scanner
Brightness" from the scan menu. Note that darkening the image may require you to lighten the form
dropout color to maintain good recognition accuracy. Follow the calibration procedure when setting up
your printer and scanner for the first time.

You can turn off the display of scanned image files by unchecking "Show Scanned Image" from the scan
menu. This will reduce the number of open windows when performing batch scanning.
You can also adjust the scanner resolution by selecting "Set Scanner Resolution" from the scan menu.
Although the optimum value for recognition accuracy is the default value of 300 DPI.
If you check "Show Scanner Interface" from the scan menu it will bring up the native interface for your
scanner. If you choose to use this method you must make sure that your scan is in black and white or fax
mode and that the image resolution is 300 DPI.

Html Report
You can generate Html reports from the database by selecting "Html Report" from the report menu.
Html reports can be viewed, saved and printed. Use the Html report toolbar for navigating multi-page
Html documents and reports.

File Menu
New
Open
Close
Save
Save As
Print
Print Preview
Print Setup
Print Forms
Print Records
Save All Processed Forms
Print All Processed Forms
Save All Scanned Images
Process All Open Images
Process Form Image
Dictionary Editor
Recent Files List
Exit

Overview
EzData application supports reading and writing of the following document types.

Form Files:
Form files are created by selecting new from the file menu. Use the form menu to add entries to the
form. Forms can then be printed for users to fill out. After printing the form can be scanned in and the
data saved to a Microsoft Access database. The database will be generated if one does not already exist.
If a database exists but you have modified the fields in the form fields in removed from the form will be
deleted in the database.
Ext:*.crf (read only)
Location: In the installation directory under the "Forms" folder. This would typically be C:\Program
Files\Creative ICR\EzData\Forms.

Image Files:
Image files are Windows form image files (.fim), bitmap, JPG, PNG, or TIFF files. The form image file
(.fim) format is identical to a windows bitmap. Image files are processed and the information is stored
into the database. Normally there is no need to save an image file to disk unless you want to save it for
processing at a later date.
Ext:*.fim (read/write)
*.bmp (read only)
Location: Anywhere the user wants to save them.

Html Report Files:
The report menu can be used to generate HTML report files from the databases. Reports can also be
created by importing the database information into Microsoft Excel or other tools that except Microsoft
access databases.
Ext:*.htm, html (read/write)
Location: Anywhere the user wants to save them.

Database Files:
Database files are Microsoft access databases that get generated when you save processed forms. The
data can then be used to generate reports and charts using the report tool. It can also be imported into
any application that accepts Microsoft access databases. An example would be Microsoft Excel.
Ext:*.mdb (read/write)
Location: In the installation directory under the "Database" folder. This would typically be C:\Program
Files\Creative ICR\EzData\Database.

Dictionary Files:
You can specify the use of a dictionary to improve the accuracy of field processing. Dictionaries are text
based files that contain a list of words or numbers. Users can create their own dictionary files using the
dictionary editor or any text editor and saving them into the dictionary directory.
Ext:*.txt (read/write)
Location: In the installation directory under the "Dictionary" folder. This would typically be C:
\Program Files\Creative ICR\EzData\Dictionary.

Form Template Files:
Form templates allow users to quickly generate a new form using predefined fields. Users can create
their own form templates by selecting a group of fields in the former editor and saving them as a
template.
Ext:*.fit (read/write)
Location: In the installation directory under the "Form Templates" folder. This would typically be C:
\Program Files\Creative ICR\EzData\Form Templates.

Character Set Files:
Character set files are used during form processing and should not be edited or modified by the user.
Location: Are stored in the application installation directory under the “CharSets” directory and are
read only files used by the application. These files should not be moved or modified.

New
Use this command to open a new form document in a new window. You can open multiple documents at
once. Use the Window menu to switch among the multiple open documents. See Window 1, 2, ...
command.

Shortcuts

Toolbar:
Keys:CTRL+N

Open
Use this command to open an existing document in a new window. You can open multiple documents at
once. Use the Window menu to switch among the multiple open documents. See Window 1, 2, ...
command.
Shortcuts

Toolbar:
Keys:CTRL+O

Close
Use this command to close all windows containing the active document. The Application suggests that
you save changes to your document before you close it. If you close a document without saving, you
lose all changes made since the last time you saved it. Before closing an untitled document, the
Application displays the Save As dialog box and suggests that you name and save the document.
You can also close a document by using the Close icon on the document's window, as shown below:

Save
Use this command to save the active document to its current name and directory. When you save a
document for the first time, the Application displays the Save As dialog box so you can name your

document. If you want to change the name and directory of an existing document before you save it,
choose the Save As command.
Shortcuts

Toolbar:
Keys:CTRL+S

SaveAs
Use this command to save and name the active document. The Application displays the Save As dialog
box so you can name your document.
To save a document with its existing name and directory, use the Save command.

Print
Use this command to print a document. This command presents a Print dialog box, where you may
specify the range of pages to be printed, the number of copies, the destination printer, and other printer
setup options.
Shortcuts

Toolbar:
Keys:CTRL+P

Print Preview
Use this command to display the active document as it would appear when printed. When you choose
this command, the main window will be replaced with a print preview window in which one or two
pages will be displayed in their printed format. The print preview toolbar offers you options to view
either one or two pages at a time; move back and forth through the document; zoom in and out of pages;
and initiate a print job.

Print Setup
Use this command to select a printer and a printer connection. This command presents a Print Setup
dialog box, where you specify the printer and its connection.

Print Forms
Use the Print Forms menu pick under the file menu to print out forms.
Print Forms Dialog:

Print Records
Use this command to print records or customized forms. A dialog is displayed that allows you to select
the desired form, records, and fields to print. You can alter the records display information by selecting
various combination of record identifiers. By default records are displayed by the record number.
This can also be used to print out forms that have fields already entered for the user. For example you
could print out a medical history sheet already having the patient name and Social Security number
filled out. Patients could then enter updates for the remaining fields.
In addition you can also perform command line record printing by using the /printrecords command line
option.

Print All Processed Forms
Use this command to print all currently open form validation windows. This command is useful if you
are processing a batch of forms and do want to print each form before closing it. Use the window menu
to close all opened forms at one time.

Save All Processed Forms
Use this command to save all currently open form validation windows. This command is useful if you
are processing a batch of forms and do not want to validate each form before saving. You can use this
command to save all open forms to the database at one time. Use the window menu to close all opened
forms at one time.

Save All Scanned Images
Use this command to save all currently open scan image windows. This command is useful if you are
processing a batch of forms and want to save the images for future processing. You can use this
command to save all open images at one time. Use the window menu to close all opened images at one
time.

Process Form Image
Use the Process Image Icon to process form images that were previously saved on disk. After opening
the image file from desk press the process image icon on the toolbar to recognize the form and display
the form validation document for saving and validating the results.

Process All Open Images
Use the Process All Open Images menu item to process all form images that are currently open. After
processing the form validation document for saving and validating the results will be displayed for each
form.

Dictionary Editor
The dictionary editor allows you to create new dictionary files or edit existing ones. Dictionary files are
useful for improving accuracy for recognition fields that have a limited possibility of expected entries.

Exit

Use this command to end your the Application session. You can also use the Close command on the
application Control menu. The Application prompts you to save documents with unsaved changes.
Shortcuts
Mouse:Double-click the application's Control menu button.

Keys:ALT+F4

Recent File List 1, 2, 3, 4
Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you
closed. Choose the number that corresponds with the document you want to open.

File Open Dialog Box
The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open. This box lists files with the extension you select in the
List Files of Type box.
List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>
Drives
Select the drive in which the Application stores the file that you want to open.
Directories

Select the directory in which the Application stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.

File Save As Dialog Box
The following options allow you to specify the name and location of the file you're about to save:
File Name
Type a new filename to save a document with a different name. A filename can contain up to eight
characters and an extension of up to three characters. The Application adds the extension you specify in
the Save File As Type box.
Drives
Select the drive in which you want to store the document.
Directories
Select the directory in which you want to store the document.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.

Print Dialog Box
The following options allow you to specify how the document should be printed:
Printer
This is the active printer and printer connection. Choose the Setup option to change the printer and
printer connection.
Setup

Displays a Print Setup dialog box, so you can select a printer and printer connection.
Print Range
Specify the pages you want to print:
AllPrints the entire document.
SelectionPrints the currently selected text.
PagesPrints the range of pages you specify in the From and To boxes.
Copies
Specify the number of copies you want to print for the above page range.
Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to produce.

Print Setup Dialog Box
The following options allow you to select the destination printer and its connection.
Printer
Select the printer you want to use. Choose the Default Printer; or choose the Specific Printer option and
select one of the current installed printers shown in the box. You install printers and configure ports
using the Windows Control Panel.
Orientation
Choose Portrait or Landscape.
Paper Size

Select the size of paper that the document is to be printed on.
Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.
Options
Displays a dialog box where you can make additional choices about printing, specific to the type of
printer you have selected.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.

Print Preview toolbar
The print preview toolbar offers you the following options:
Print
Bring up the print dialog box, to start a print job.
Next Page
Preview the next printed page.
Prev Page
Preview the previous printed page.
One Page / Two Page
Preview one or two printed pages at a time.
Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.
Close
Return from print preview to the editing window.

Window Menu
Cascade
Tile
Arrange Icons
Close All
Open Window List

Cascade
Use this command to arrange multiple opened windows in an overlapped fashion.

Tile
Use this command to arrange multiple opened windows in a non-overlapped fashion.

Arrange Icons
Use this command to arrange the icons for minimized windows at the bottom of the main window. If
there is an open document window at the bottom of the main window, then some or all of the icons may
not be visible because they will be underneath this document window.

Close All
Use this command to close all opened document windows.

Open Window List 1, 2, …
The application displays a list of currently open document windows at the bottom of the Window menu.
A check mark appears in front of the document name of the active window. Choose a document from
this list to make its window active.

Form Menu
Form Attributes
Forum Processing Engine Settings
Form Colors
Templates
Add Custom Template
Save Custom Template
Item
Add Box
Add Line
Add Text
Add Bitmap
Add CheckBox
Add TextBox
Add Image Box
Add BarCode Box
Create GroupBox
Group
Group Selected Items
Ungroup Selected Items
Duplicate Group
Align
Lefts
Rights
Tops
Bottoms
Edit
Move
Delete
Value
Edit Value
Save Value Set
Load Value Set
Delete Value Set
Hide Value
Show Value
Set Field Points
Send To Back
Send To Front

Snap To Grid
Show Grid
Set Image Name
Dictionary Editor

Form Attributes
Use this command to edit a forms attributes. Form attributes include items like the number of pages, size
of the form, a title for the form, and the size of the form.

Form Process Engine Settings
Use this command to change the engines used when a field gets processed. You can choose to use all
engines with a voting algorithm for the final result or choose one of the other 3 engines for processing a
fields value. Choosing all engines will generally give you better accuracy and confidence indication
however it increases processing time slightly.

Add Custom Template
Use this command to create a custom field template. A custom field template is a field or set of fields
that are predefined and simplify the form creation process.

Save Custom Template
Use this command to save a custom template. A custom field template is a field or set of fields that you
would like to save for future use in other forms. To create a custom template simply select a group of
fields in the form and use this menu item to save them.

Add Box
Use this command to add a box to the form. Boxes are purely for decoration and organization and should
not be used as text recognition fields.
Shortcuts

Toolbar:

Add Line
Use this command to add a line to the form. Lines are purely for decoration and organization.
Shortcuts

Toolbar:

Add Text
Use this command to add text to the form. Text is purely for decoration and organization.
Shortcuts

Toolbar:

Add Bitmap
Use this command to add a bitmap image to the form.
Shortcuts

Toolbar:

Add Textbox
Use this command to add a textbox recognition field to the form. Text box recognition fields will be
processed to read any and written characters entered into them.
Shortcuts

Toolbar:

Add Checkbox
Use this command to add a checkbox recognition field to the form. Checkbox fields will be processed to
detect any check to fields.
Shortcuts

Toolbar:

Add Image Box
Use this command to add a image recognition field to the form. Barcode recognition fields are useful for
capturing the value and type of a barcode that you want preserved in the database.

Add BarCode Box
Use this command to add a barcode recognition field to the form. Image recognition fields are useful for
capturing signatures or other images that you want preserved in the database.

Create GroupBox
Use this command to create a a group box and group title around the selected set of items. After the
group box and title are created you can edit them by double-clicking on the item you wish to edit or
selecting it and selecting edit from the form menu.

Group Selected Items
Use this command to create a database group for the set of selected items. There can only be one group
definition in a form although you can create as the duplicate groups as needed to populate the form.
Database groups allow multiple records to be created for a single form. A good example of this would be
an exercise log that allowed to to enter a date, the distance you ran, and how many calories you burned.
Using database groups you could repeat this set of fields numerous times on the form and for each

occurrence found a new record would be entered into the database. Normally there is only one record for
each form scanned in.

Ungroup Selected Items
Use this command to remove a database group for the set of selected items.

Duplicate Group
Use this command to duplicate a database group for the set of selected items. You can also use copy and
paste to perform the same function.

Edit
Use this command to edit the selected item in a form. If you have multiple items selected a special
dialog is displayed to make edits to all of the selected items. If only a single item is selected the normal
item dialog is displayed.

Move
Use this command to move the selected items in the form.

Delete
Use this command to delete the selected items in the form.

Save Value Set
Use this command to save the current values for all recognition in text fields as a set. These values can
then be loaded back in at a later time. Example of how you might use this feature is in attendance sheet.
Each class would have their own value set saved so they can be noted before printing to avoid having to
enter names for each person in the attendants sheet.
You can also save an <Expected Value> set that can be used for validating the answers supplied to
fields. For example a teacher may want to ask a series of questions and have EzData validate the

answers given and display the percentage of correct entries. Editing each fields value and then saving the
values as an expected value set allows you to do this. You also need to define a point value for each
field. Fields with a point value of 0 are ignored when calculating the percentage of correct entries.
When you create an <Expected Value> set it automatically adds the fields below to the database to
record correct value and point information.
Database Fields:
TotalPossibleAnswers
TotalWrongAnswers
TotalPossiblePoints
TotalWrongPoints
Load Value Set
Use this command to load a save values set.

Delete Value Set
Use this command to edit the value displayed in a recognition or text field. This can be used to set values
for form fields or to change values before saving to the database when validating form. You can use this
feature to set values for a form before printing it out. This could be used to avoid users having to
manually enter data for these fields.
When you create an <Expected Value> set it automatically removes the fields below to the database to
record correct value and point information.
Database Fields:
TotalPossibleAnswers
TotalWrongAnswers
TotalPossiblePoints
TotalWrongPoints
Edit Value
Use this command to edit the value displayed in a recognition or text field. This can be used to set values

for form fields or to change values before saving to the database when validating form. You can use this
feature to set values for a form before printing it out. This could be used to avoid users having to
manually enter data for these fields. You can use the Tab and Shift Tab keys to navigate to the next in
previous fields.
You can use the Tab key to navigate to the next field. Holding the Shift key while pressing the Tab key
will take you to the previous field. To close the correction/edit window without saving the changes press
the Esc key. To close the correction/edit window and apply the changes just click on any blank area in
the form.

Hide Selected Values
Use this command to hide values displayed in a selected fields.

Show Selected Values
Use this command to show values displayed in a selected fields. Forms can be printed with default
values displayed for fields that you would like to be fixed in value yet it displayed and saved to the
database when scanned.

Send To Back
Use this command to send an item to the back of the display. This insures it will be displayed behind
other items in the form.

Send To Front
Use this command to bring an item to the front of the display. This insures other items in the form will
not obscure the item.

Snap To Grid
Use this command to cause items to be moved to the closest grid location when you move them.

Show Grid

Use this command to display the current grid. If the grid is to fine to be displayed it will automatically
adjust the visible grid lines so the display is reasonable. This does not affect the actual grid points that
will be used when snapping items to the grid.

Set Field Points
Use this command to edit the points associated with a particular field for fields. The points are used in
determining an overall score when comparing actual values with the expected values. All fields that
have a point value of 0 will be ignored when doing comparison in calculating the overall score.

Set Image Name
Use this command to set the base name of the image when automatically saving scanned images. By
default it is set to the form name and the current date and time. You can choose to set it to almost any
field name in your form. For example you could use a Social Security number to uniquely identify the
saved scanned images.

Form Colors
Use this command to set the form dropout color and form registration mark color.

Align
Use these commands to align a group of selected fields.

Align Lefts
Use this commands to align a group of selected fields to the left edge of the left most field.

Align Rights
Use this commands to align a group of selected fields to the right edge of the right most field.

Align Tops

Use this commands to align a group of selected fields to the top edge of the top most field.

Align Bottoms
Use this commands to align a group of selected fields to the bottom edge of the bottom most field.

Edit Menu
Cut
Copy
Paste
Undo
Redo
Selected All
Select All Items
Deselect All
Application Preferences
Default Scanner
Scanner Resolution
Scanner Brightness
Display Scanner Interface
Show Form Process Errors
Auto Save/Close Form Data
All Engines
Primary Engine
Secondary Engine
Tertiary Engine
Quad Engine
Use Primary Engine Values
Use Secondary Engine Values
Display Image
Auto Save/Close Form Image
Image Directory
Image Conversion Threshold
Analysis Results Directory
Field Box Dropout Color
Registration Mark Color
Form Directory
Database Directory
Dictionary Directory
Form Template Directory
Generate HTML Report
HTML Report Directory
Auto Processing

Cut
Use this command to remove the currently selected data from the document and put it on the clipboard.
This command is unavailable if there is no data currently selected.
Cutting data to the clipboard replaces the contents previously stored there.
Shortcuts

Toolbar:
Keys:CTRL+X

Copy
Use this command to copy selected data onto the clipboard. This command is unavailable if there is no
data currently selected.
Copying data to the clipboard replaces the contents previously stored there.
Shortcuts

Toolbar:
Keys:CTRL+C

Paste
Use this command to insert a copy of the clipboard contents at the insertion point. This command is
unavailable if the clipboard is empty.
Shortcuts

Toolbar:

Keys:CTRL+V

Undo
Use this command to reverse the last editing action, if possible. Currently undo/redo is not supported for
database commands.
Shortcuts

Toolbar:
Keys:CTRL+Z

Redo
Use this command to reverse the undo editing action, if possible. Currently undo/redo is not supported
for database commands.
Shortcuts

Toolbar:
Keys:CTRL+Y

Select All
Use this command to select all items in a form.
Shortcuts
Keys:CTRL+A

Select All Items
Use this command to select all specified item types in a form.

Deselect All
Use this command to deselect all items in a form.

Application Preferences Dialog
Use this command to edit the configurable application preferences.
Default Scanner
Set default scanner to use during image acquisition.
Scanner Resolution
For optimum results a scanner resolution of 300DPI is recommended.
You can adjust the scanner resolution to speed up the scanning process. If you find you are not having
accuracy problems you can set the scanner resolution as low as 200DPI with out much accuracy loss.
Use this feature if you are letting the application control the scanning process.
If you are using your Scanners native interface to control scanning then it is up to you to pick the right
resolution. Increasing the resolution to more than 300DPI will most likely decrease the accuracy.
Also insure that images are not scaled by more than 5 to 7% to ensure the form its properly registered
and can be processed by EzData.
Scanner Brightness
Change the scanner black and white threshold to calibrate the scanner for your style of writing and
preference in pens or pencils. Setting it to a larger number will darken the image and ensure that light
pencil marks are scanned correctly and improve accuracy. The default value is 128 and the range is 0 to
255.
Anytime you darken the black and white threshold setting make sure and recheck the form text outlined
boxes still drop out when the form is scanned in. If any of the form text outline boxes show up in the
form image then use the Set Form Dropout Color dialog to lighten the color in the printed forms. Even
small dots left over on the scanned in image can cause a decrease in recognition accuracy.
For an example see the form calibration dialog.

Display Scanner Interface
Use the Show Scanner Interface feature to show the native scanner interface supplied with the scanner
for scanning in forms. After scanning the image the active document will be displayed. You will may
need to use Process Form Image to recognize the form and display the form for validation and saving to
the database.
Show Form Process Errors
Show warnings during form processing. For example if a single selection checkbox has no selections a
warning would be issued.
Auto Save/Close Form Data
This feature automatically saves processed forms to the database and then closes the form file.
All Engines
This feature selects all of the character recognition engines to be used during form processing. This
improves the overall accuracy by using a voting algorithm to determine the final value used. In addition
when manually verifying data the color indicators showing the confidence in the answer will also be
more reliable. If a dictionary match was used the color will be brown. The color black is used for the
highest confidence, orange for medium, and red for poor.
Primary Engine
This feature selects the primary character recognition engine to be used during form processing. The
accuracy of the primary character recognition engine is in general superior for tough to read images.
Secondary Engine
This feature selects the secondary character recognition engine to be used during form processing.
Tertiary Engine
This feature selects the tertiary character recognition engine to be used during form processing.
Quad Engine
This feature selects the tertiary character recognition engine to be used during form processing.

Display Image
This feature will display this can be an image as well as the processed form. The image can be used for
verification purposes or saved if required.
Auto Save/Close Form Image
This feature automatically saves scanned images to the disk and then closes the image file. The file is
saved in the default image directory.
Image Directory
This is the default location to save a scanned images to.
Image Conversion Threshold
This is the color threshold used to convert color images to black-and-white. When processing color
images you may need to adjust this threshold to ensure the character boxes drop out correctly and the
text is dark and clear.
Analysis Results Directory
This is the default location to save a analysis results (charts/reports) to.
Field Box Dropout Color
Use this feature to change the color of the form field boxes. This may be necessary to compensate for
variations in printers and scanners. It is important that no part of the form field boxes shows up on in the
scanned in image. Even small dots can cause a decrease in character recognition accuracy. Other colors
can be used beside light blue but it yields the best performance for most scanners.
The default color settings using the for the color dialog are: Red=200, Blue=255, Green=255.
Registration Mark Color
Set the color used for the registration marks. It is important the color is dark enough to produce clear
solid black rings on the scanned images. Without this performed will not be able to properly register
itself.
Form Directory

This is the default location to save forms to.
Database Directory
This is the default location to save databases to.
Dictionary Directory
This is the default location to save form field dictionaries to.
Form Template Directory
This is the default location to save form deal templates to.
Generate HTML Report
Use this field to set automatic generation of HTML form processing reports.
HTML Report Directory
This is the default location to save form deal templates to.
Auto processing
This feature allows EzData to monitor an existing directory for new images to automatically process.
You can control the frequency at which the directory is monitored for new images to process. In addition
you can specify the location to move successfully processed image files to as well as ones with errors.

Scan Menu
Select Scanner
Deselect Scanner
Scan New Image
Calibration Help

Select Scanner
Use the Select menu item under the scanner menu to select the desired scanner to use with application. This step
is only required the first time you use a different or new scanner. The application will remember the selected
scanner allowing you to skip this step and just click on the "Scan New Image" menu item to scan in the
documents.

Deselect Scanner
Use the Deselect Scanner menu item under the scanner menu to deselect the scanner being used by the
application. This will allow other applications to access the scanner.

Scan New Image

Use the Scan Icon on the Toolbar or the scanner menu to start a scan and process the scanned image.
By default EzData will directly access and control the scanner via the TWAIN interface standard. Note that not
all scanners provide adequate control of image resolution and threshold via the TWAIN interface. Scanning
black and white images may require adjusting the threshold used to determine a black from a white pixel to
insure sharp text and dropout of the image character outlined boxes. If changing these values in the application
preferences dialog does not change the scanned image then choose the option to display the scanners interface.
From the scanners own interface you should be able to adjust the image acquisition preferences as needed to
attain optimum character recognition.
In addition you can also perform command line batch scanning by using the /batchscan command line option. If
you have set the application preferences to automatically generate an HTML form processing report you can
review the results after the scanning has completed.

Show Calibration Help

This dialog shows how to calibrate the application for your scanner and printer.
See also Optimizing Character Recognition
Calibration Help Dialog:

View Menu
Toolbar
Database Toolbar
Form Toolbar
Html Toolbar
Status Bar
Zoom In
Zoom Out
Zoom All
Zoom 100%

Toolbar
Use this command to display and hide the main Toolbar, which includes buttons for some of the most
common commands in the application, such as File Open. A check mark appears next to the menu item
when the Toolbar is displayed. It can be moved using the mouse to drag and drop it.

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar
provides quick mouse access to many tools used in the application,
To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).
ClickTo

Open a new form document.

Open an existing document. The Application displays the Open dialog box, in which you can locate
and open the desired file.

Save the active document or template with its current name. If you have not named the document,
the Application displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Zooms the image making it appear smaller on the screen.

Zooms the image making it fit into the existing window.

Zooms the image to default or 100%.

Zooms the image making it appear larger on the screen.

Scan in a new form image and process it.

Process the active or displayed form image document.

Use this to get help about a specific item like a Menu or Icon

Displays the copyright and company information.

Database Toolbar
Use this command to display and hide the database Toolbar, which includes buttons for some of the
most common database commands in the application, such as Record Save. A check mark appears next
to the menu item when the Toolbar is displayed. It can be moved using the mouse to drag and drop it.

To hide or display the Database Toolbar, choose Database Toolbar from the View menu (ALT, V, D).
ClickTo

Open a database for editing/viewing.

Save edits to the active database record.

Create a new database record for editing.

Delete the active record.

Cancel edits on the active record and refresh the data.

Go to the first record in the active database.

Go to the previous record in the active database.

Go to the next record in the active database.

Go to the last record in the active database.

Find a record in the active database.

Form Toolbar
Use this command to display and hide the form Toolbar, which includes buttons for some of the most
common form commands in the application, such as adding new textbox or checkbox fields. A check

mark appears next to the menu item when the Toolbar is displayed. It can be moved using the mouse to
drag and drop it.

To hide or display the Form Toolbar, choose Form Toolbar from the View menu (ALT, V, F).
ClickTo

Creative a new form for editing/viewing.

Add new text box field.

Add do checkbox field.

Add new text.

Add a new line.

Add a new box.

Add a new bitmap image.

Html Toolbar
Use this command to display and hide the Html Toolbar, which includes buttons for some of the most
common Html commands in the application, such as next and previous page. A check mark appears next
to the menu item when the Toolbar is displayed. It can be moved using the mouse to drag and drop it.

To hide or display the Html Toolbar, choose Html Toolbar from the View menu (ALT, V, H).

ClickTo

Go to Html homepage.

Refresh Html document view.

Go to previous Html page.

Go to next Html page.

Status Bar

The status bar is displayed at the bottom of the application window. To display or hide the status bar, use
the Status Bar command in the View menu.
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus. This area similarly shows messages that describe the actions of toolbar buttons as you
depress them, before releasing them. If after viewing the description of the toolbar button command you
wish not to execute the command, then release the mouse button while the pointer is off the toolbar
button.
The right areas of the status bar indicate which of the following keys are latched down:
To hide or display the Status bar, choose Status bar from the View menu (ALT, V, H).
Indicator Description
LOCATION:

Indicates the X,Y location in image documents and form documents.

RECORD NUMBER:
CAP:
NUM:

Indicates the active or current database record number.

The Caps Lock key is latched down.
The Num Lock key is latched down.

SCRL:

The Scroll Lock key is latched down.

Zoom In

Zooms the image making it appear larger on the screen.

Zoom Out

Zooms the image making it appear smaller on the screen.

Zoom All

Zooms the image making it fit into the existing window.

Zoom 100%

Zooms the image default or 100%.

Analyze Menu
Html Report
Home
Back
Forward
Refresh

Html Report
Use this command to generate database reports in and Html format. To generate a report document
select "Html Report" from the report menu. This will display the report dialog allowing you to select the
database you wish to generate reports from as well as the columns in the database that you and displayed.

Html Home
Use this command to the Html home page.

Html Back
Use this command to go back one Html page.

Html Forward
Use this command to go forward one Html page.

Html Refresh
Use this command to refresh an Html page.

Troubleshooting
Solution Guide
Contact Support

Overview
Creative ICR, Inc. is dedicated to providing the highest quality software and support. Please be sure and
report any problems found by going to http://www.creativeicr.com too file a bug report or email
support@creativeicr.com with the details of the problem.
Please include the type of computer including the processor type and speed, printer type, scanner type,
and as much other detail about the problem as you can. The more information you can supply the easier
to find and fix the problems and in return give you a better quality product.

Contact Support
For support in installing the application or to report problems encountered while using it send email to
support@creativeicr.com or use the Internet to go to http://www.creativeicr.com. Creative ICR, Inc. is
dedicated to providing the highest quality software and support.

Solution Guide
Problems Scanning
Problems Registering Form
Problems With Recognition Accuracy
Problems With Form Layout

Problems Scanning
Problems:
●
●
●

Nothing happens when the scan image icon is pressed.
Scanning starts but does not complete.
Scan image only works the first time after that nothing happens.

Solutions:

●

●

●

●

Be sure you have a scanner selected. If scanning is not enabled the icon should appear gray in
appearance. Use the Scanner Select menu pick under the Scanners Menu to select a scanner.
Try checking the Show Scanner Interface button under the Scanners Menu. This should bring up
the native scanner interface to do the scan and avoid problems that may occur with scanners the
claim to be TWAIN compliant but are not.
Scan the image outside of the application and use the File Open icon to load the scanned in file
and Process the image.
Note that many applications such as Microsoft painted do not set the image resolution for
scanned images. Images that do not have a correctresolution setting cannot be scanned.

Problem:
●

When the application is being used I am not able to use the scanner for other applications.

Solutions:
●

Use the Deselect menu pick under the Scanner Menu to disconnect the application from the
scanner.

Problems Registering Form
Problem:
●

You get an error message about the form not being able to be recognized.

Solutions:
●

●

●

●

Make sure the form was printed on a color ink jet printer that can deliver laser quality prints.
Forms that are printed in black and white will not work with the application.
Check the form identification number area for any pencil marks. The application reads the form
identification number to determine which form it is and how to process the data. Pencil or other
marks in this area could cause the name to be read incorrectly.
Check the area around the 3 registration circles for any pencil marks. The application uses these
marks to correct for any form rotation and to determine the location of the fields. It must be able
to accurately locate all three marks.
If the above items do not fix the problem then it may be necessary to manually enter the data for
that form.

Problems With Recognition Accuracy
Problem:
●

The recognition accuracy is not very good.

Solutions:
●

●
●
●

Make sure the form was printed on a color ink jet printer that can deliver laser quality prints.
Forms that are printed in black and white will not work with the application.
Use a dark pencil or black pen and press firmly.
Try writing in a clear in block style printing.
Calibrate the Scanner Brightness and the Form Dropout Color.

●

Problems With Form Layout
Problem:
●

Form items are overlapping after printing or win zoomed in or out but looked fine when initially
placed.

Solutions:
●

Unfortunately the windows operating system does not always display fonts exactly the same as
they will be printed. Also when zooming in or out the windows operating system tries to pick the
closest font match available. Sometimes the size of the font as well as other characteristics will
cause items to be printed out overlapping or display overlapping on the screen. The best solution
is to lay out the form with the zoom factors set to 100 percent. In addition pick common fonts
like Arial, Courier and Times for text based items. This ensures the best possibility for the screen
fonts to match the printer fonts. Checkbox fields are the most affected by fonts mismatch
problems due to the fact the bounding box is sized based on the text size.

Help Menu
Help Topics
Quick Reference Guide
Purchase Online
Support
Product Evaluation
Example Forms
Example Images
Show License Information
Update License Information

Help Topics
Use this command to bring up the main help window.

Quick Reference Guide
Use this command to launch the HTML quick reference guide window.

Product Evaluation
Use the example forms and example images accessed through the help menu to evaluate the product
perfomance.

Example Forms
Use this command to load example forms to print, fill out and scan. This allows you to evaluate the
product performance without having a valid license key. After printing and filling out a form place it in

the scanner and press the scan icon or use the scanner menu to scan the new image. Some printer/
scanner calibration may be required form optimum accuracy.

Example Imges
Use this command to load example form images for processing. This allows you to evaluate the product
performance without having a valid license key. After loading and example image press the process
image icon or use the file menu item for processing the form image.

Support
Use this command to go to the support web page.

Purchase Online
Use this command to bring up a web browser window allowing you to purchase the product.

Show License Information
Use this command to show the current licensing information.

Update License Information
Use this command to change the current license settings.

Update License Dialog:

Database Menu
Open Form
Database
Import Data
Export Data
Save Record
Add Record
Clear Field Values
Delete Record
Cancel Edits
First Record
Next Record
Previous Record
Last Record
Find Record
Deleate All Records

Open Form Database
Use this command to open a form database for editing. You can use this command on new forms to
manually enter records.

Import Data
Use this command to import data from a text file to a database. The file must contain field name and
field values in a comma or tab separated format. You can use the output of the export data command as
an example for the expected format.

Export Data
Use this command to export data from a database. The output will be field name and field values using a
comma for the delimiter. In addition you can also perform command line exporting by using the /
exportdata command line option.

Save Record

Use this command to save changes to the current record.

Add Record
Use this command to add a new record to the database.

Clear Field Values
Use this command to clear the field values for the current record from the database.

Delete Record
Use this command to delete the current record from the database.

Cancel Record
Use this command to cancel edits of the current record and refresh or reload the record from the
database.

First Record
Use this command to move to the first record in the database.

Previous Record
Use this command to move to the previous record in the database.

Next Record
Use this command to move to the next record in the database.

Last Record
Use this command to move to the last record in the database.

Find Record
Find and display a record in the database. This command displays a dialog that allows you to select the
column or field that you wish to search for. For more complicated searches you can select up to two
columns.

Delete All Records
Use this command to delete all records in the database.

